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Dear editor,  

 

 We submit an article titled “Examination of mitotic and meiotic fission yeast nuclear dynamics 

by fluorescence live-cell microscopy” for your publication and video production consideration. We 

believe the simplicity of this protocol will help many yeast researchers answer important cell biology 

questions through live-cell fluorescence microscopy. We provide a method to successfully prepare 

fission yeast samples for prolonged fluorescence visualization. We also offer basic ImageJ analysis steps 

that researchers can follow to give meaning to their real-time microscopy observations of mitotic and 

meiotic events.  

 Although there are live-cell imaging protocols in the literature that successfully address real-

time events during mitosis, few focus on the time-sensitive process of meiotic progression. In this 

methods paper, we present an optimized approach that has worked well in our hands and which 

produces abundant information from just a few live-cell videos. Provided researchers follow 

recommendations we stipulate in the manuscript, we believe they can study multiple aspects of meiosis 

that are difficult to examine through biochemical or molecular biology approaches. Some of the 

processes that we highlight, and which are amenable to our methods, deal with the timing, stability, and 

movement dynamics of nuclear events. For this reason, we ask for your serious consideration of this 

work. 

 

Sincerely, 

 

 

Wilber Escorcia, Ph.D 
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SUMMARY:  25 
Here, we present live-cell imaging which is a non-toxic microscopy method that allows 26 
researchers to study protein behavior and nuclear dynamics in living fission yeast cells during 27 
mitosis and meiosis.  28 
 29 
ABSTRACT:  30 
Live-cell imaging is a microscopy technique used to examine cell and protein dynamics in living 31 
cells. This imaging method is not toxic, generally does not interfere with cell physiology, and 32 
requires minimal experimental handling. The low levels of technical interference enable 33 
researchers to study cells across multiple cycles of mitosis and to observe meiosis from beginning 34 
to end. Using fluorescent tags such as Green Fluorescent Protein (GFP) and Red Fluorescent 35 
Protein (RFP), researchers can analyze different factors whose functions are important for 36 
processes like transcription, DNA replication, cohesion, and segregation. Coupled with data 37 
analysis using Fiji (a free, optimized ImageJ version), live-cell imaging offers various ways of 38 
assessing protein movement, localization, stability, and timing, as well as nuclear dynamics and 39 
chromosome segregation. However, as is the case with other microscopy methods, live-cell 40 
imaging is limited by the intrinsic properties of light, which put a limit to the resolution power at 41 
high magnifications, and is also sensitive to photobleaching or phototoxicity at high wavelength 42 
frequencies. However, with some care, investigators can bypass these physical limitations by 43 
carefully choosing the right conditions, strains, and fluorescent markers to allow for the 44 
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appropriate visualization of mitotic and meiotic events.  45 
 46 
INTRODUCTION:  47 
Live-cell microscopy allows researchers to examine nuclear dynamics without killing fission yeast 48 
cells and eliminates the need for lethal fixatives and stains. It is possible to observe the stability, 49 
movement, localization, and timing of fluorescently tagged proteins that are involved in 50 
important events such as chromosome replication, recombination, and segregation, in addition 51 
to the membrane and cytoskeletal movements. By maintaining cell viability and non-toxic signal 52 
detection, there is minimal physiological intrusion. When performed properly, this microscopy 53 
method can reduce confounding effects that arise from the extended technical handling or from 54 
spurious chemical reactivity. Furthermore, during an experiment, researchers can make 55 
pertinent observations of fission yeast nutritional and stress states, proliferative efficiency, and 56 
apoptotic status that indicate inappropriate imaging parameters or abnormal cell physiology1-3.  57 
 58 
Mitosis and meiosis are characterized by nuclear and cellular division. In meiosis, contrary to 59 
mitosis, genetic content is halved as parent cells give rise to daughter cells4. Because live-cell 60 
imaging provides a temporal dimension in addition to the spatial relationship, large numbers of 61 
cells can be examined in real-time. Live-cell microscopy has enabled researchers to examine the 62 
dynamics of nuclear division using fluorescent tags for histones5, cohesin subunits6, 63 
microtubules7, centromeres8, kinetochores9, components of the spindle pole body (SPB)10, and 64 
those of the chromosome passenger complex (CPC)11. Outside of the chromosome segregation 65 
apparatus, live-cell imaging has also captured the behavior of proteins necessary, but not directly 66 
involved in chromosome segregation. The function of these proteins has been shown to influence 67 
replication, chromosome recombination, nuclear movement, and chromosome attachment to 68 
microtubules12-14. These observations have contributed to a better understanding of cellular 69 
events whose functional components were not amenable to biochemical or genetic examination. 70 
With new advances in microscopy technology, limitations such as poor resolution, 71 
photobleaching, phototoxicity, and focus stability will lessen, thereby facilitating better real-time 72 
observations of mitotic and meiotic nuclear dynamics1-3. Meiosis is particularly challenging as it 73 
is a terminal differentiation pathway that requires close attention to timing.  74 
 75 
The goal of this protocol is to present a relatively simple method for examining real-time fission 76 
yeast nuclear dynamics in mitosis and meiosis. To accomplish this, it is necessary to use cells that 77 
have not been exposed to environmental stress, prepare agarose pads that can withstand 78 
prolonged imaging, and mount cells at densities that facilitate visualization of single-cell 79 
dynamics. Moreover, this protocol makes use of cells carrying fluorescently tagged proteins that 80 
serve as useful markers for nuclear kinetics (Hht1-mRFP or Hht1-GFP), chromosome segregation 81 
(Sad1-DsRed), cytoskeleton dynamics (Atb2-mRFP), transcriptional activation in G1/S (Tos4-GFP), 82 
and cohesion stability in meiosis (Rec8-GFP). This method also introduces additional nuclear and 83 
cytosolic markers (Table I) that can be used in different combinations to address questions about 84 
specific cellular processes. Furthermore, basic Fiji tools are featured to help researchers process 85 
live-cell images and analyze different types of data. The strength of this approach stems from the 86 
use of real-time observations of protein dynamics, timing, and stability to describe processes that 87 
are integral for the proper execution of mitosis and meiosis.  88 



   

 
 

 89 
PROTOCOL:  90 
 91 
1. Media preparation15,16  92 
 93 
1.1. Stock solutions 94 
 95 
1.1.2. Prepare a 50x salt stock solution by adding 52.5 g of MgCl2·6H20, 0.735 g of CaCl2·2H20, 50 96 
g of KCl, and 2 g of Na2S04 in a bottle containing 1 L of distilled water. Mix the solution thoroughly 97 
and sterilize by filtration. Place at 4 °C for long-term storage.  98 
 99 
1.1.3. Make a 1,000x vitamin stock solution by mixing 1 g of pantothenic acid, 10 g of nicotinic 100 
acid, 10 g of inositol, and 10 mg of biotin in a bottle containing 1 L of distilled water. Mix the 101 
solution well and sterilize by filtration. Keep at 4 °C for long-term storage. 102 
 103 
1.1.4. Prepare a 10,000x mineral stock solution by adding 5 g of boric acid, 4 g of MnSO4, 4 g of 104 
ZnSO4·7H2O, 2 g of FeCl2·6H2O, 1 g of KI, 0.4 g of molybdic acid, 0.4 g of CuSO4·5H20, and 10 g of 105 
citric acid in a bottle containing 1 L of distilled water. Mix the solution thoroughly and sterilize by 106 
filtration. Place at 4 °C for long-term storage.  107 
 108 
1.1.5. Make individual nutrient stock solutions by adding 7.5 g of either adenine, leucine, histidine 109 
or lysine into a bottle containing 1 L of distilled water. Use only 3.75 g to make the uracil solution. 110 
Sterilize solutions by autoclaving.  111 
 112 
NOTE: Over time, uracil precipitates out of solution. To bring into the solution again, warm in the 113 
microwave at 60% power in 10 s increments or place in a 55 °C water bath for 20 min. Swirl the 114 
warm solution until all uracil clumps disappear.  115 
 116 
1.2. Yeast extract plus supplements (YES)  117 
 118 
1.2.1. In a 2 L flask, add 1 L of distilled water, 5 g of yeast extract base, 30 g of glucose, and 225 119 
mg each of adenine, uracil, L-histidine, L-leucine, and L-lysine. Add 20 g of agar to make the solid 120 
medium. 121 
 122 
1.2.2. Use a magnetic stir bar to completely dissolve ingredients into the solution. Agar will melt 123 
after the medium is sterilized by autoclaving.  124 
 125 
NOTE: For convenience, ready-to-use YES powder is also commercially available.  126 
 127 
1.3. Edinburgh minimal medium (EMM) and pombe glutamate medium (PMG) 128 
 129 
1.3.1. In a 2 L flask, combine 1 L of distilled water with 3 g of potassium hydrogen phthalate, 2.2 130 
g of Na2HPO4, 5 g of NH4Cl, 20 g of glucose, 20 mL of salt stock solution, 1 mL of vitamin stock 131 
solution, and 0.1 mL of mineral stock solution. Replace NH4Cl with 2.2 g of L-glutamic acid 132 



   

 
 

monosodium salt to prepare PMG. To make the solid medium, add 20 g of agar.  133 
 134 
1.3.2. Using a magnetic stir bar, dissolve ingredients thoroughly. Agar will melt after the medium 135 
is sterilized by autoclaving. Before use, add nutrient stock solutions as necessary. For every 1 L of 136 
medium, add 15 mL each of adenine, leucine, histidine, and lysine. Use 30 mL for uracil, since it 137 
is less concentrated than the other nutrient solutions.  138 
 139 
NOTE: For convenience, ready-to-use EMM and PMG powders are also commercially available.  140 
 141 
1.4. Malt extract (ME) 142 
 143 
1.4.1. Use a 2 L flask to mix 1 L of distilled water with 30 g of malt extract and 225 mg each of 144 
adenine, uracil, histidine, and leucine. Adjust the pH to 5.5. Include 20 g of agar to make the solid 145 
medium.  146 
 147 
1.4.2. Dissolve components into the solution using a magnetic stir bar. Agar will melt after the 148 
medium is sterilized by autoclaving.   149 
 150 
1.5. Sporulation agar with supplements (SPAS) 151 
 152 
1.5.1. In a 2 L flask, add 1 L of distilled water, 10 g of glucose, 1 g of KH2PO4, 1 mL of vitamin stock, 153 
45 mg each of adenine, uracil, histidine, leucine, and lysine hydrochloride. Add 20 g of agar to 154 
make the solid medium. 155 
 156 
1.5.2. Use a magnetic stir bar to thoroughly combine ingredients. Agar will melt after the medium 157 
is sterilized by autoclaving. 158 
 159 
2. Fission yeast culture15,16  160 
 161 
2.1.1. Use YES solid medium to wake up fission yeast strains from cryogenic preservation. 162 
Depending on the temperature requirements of each strain, incubate at either 25 °C or 32 °C for 163 
3-5 days.  164 
 165 
2.1.2. When colonies are visible, prepare a starter liquid culture. Pick cells from individual 166 
colonies and inoculate them into test tubes containing 3 mL YES liquid medium. Grow at the 167 
appropriate temperature to the mid- or late-log phase.  168 
 169 
NOTE: For proper aeration, use tubes or flasks with volumes at least 5x greater than the intended 170 
liquid culture volume. Shaking speeds between 150-220 rpm are customary for routine culture 171 
growth.  172 
 173 
2.1.3. Dispense 250-500 µL of starter culture into a 50 mL flask containing 9.5-9.75 mL of either 174 
YES, EMM or PMG plus appropriate supplements. Allow cells to grow to the desired density and 175 
check under the microscope for the proper cell morphology and nutritional state.  176 



   

 
 

 177 
NOTE: To store awoken strains for up to a month, seal YES plates with paraffin tape and place at 178 
4 °C.  179 
 180 
3. Sample preparation2 181 
 182 
3.1. Microscope slide setup  183 
 184 
3.1.1. Add 2 g agarose in a 500 mL beaker containing 100 mL of either minimal medium plus 185 
supplements (mitosis) or liquid SPAS (meiosis). Warm the agarose solution in a microwave oven 186 
at 60% power in 10 s increments or place in a 55 °C water bath for 10 min. Swirl the solution to 187 
ensure efficient melting. Prepare agarose slide-making setup (Figure 1A) to ensure quick pad 188 
preparation and prevent molten agarose from solidifying prematurely.  189 
 190 
3.1.2. Allow the molten agarose to cool for 1 min at room temperature and dispense 50-100 µL 191 
spots on microscope slides using wide-bore pipette tips. Before the agarose cools down, place a 192 
microscope slide on the top to generate a spread pad of about 1.5-2 cm in diameter (Figure 1B-193 
C). The width of the agarose pad is typically proportional to the length of imaging time. In other 194 
words, thicker pads withstand longer imaging periods. 195 
 196 
3.1.3. Use a hydrocarbon mixture as a sealant to ensure proper coverage of slides with thick 197 
agarose pads and to prevent cell death from solvent exposure at the coverslip edges. Mix equal 198 
parts (w/w) of petroleum jelly, lanolin, and paraffin in a 500 mL beaker. Heat ingredients on a hot 199 
plate at 120 °C for 5 min. As components melt, carefully swirl the molten solution to ensure 200 
appropriate mixing.      201 
 202 
3.2. Sample setup  203 
 204 
3.2.1. For the examination of mitotic events, grow cells from starter cultures in either liquid EMM 205 
or PMG plus supplements to approximately mid-log phase (OD595 of 0.4). Centrifuge 1 mL of the 206 
cell suspension at 1,375 x g for 1 min, remove the supernatant and resuspend the cell pellet in 207 
the minimal medium plus supplements to a final volume of 100 µL.  208 
 209 
3.2.2. To image meiotic events, grow cells from starter cultures in the minimal medium plus 210 
supplements to late-log phase (OD595 of 0.7-1.0). Combine equal volumes of opposite mate-type 211 
cells (h- and h+) in a 1 mL cell suspension. Centrifuge cells at 1,375 x g for 1 min and resuspend 212 
the pellet in liquid ME. Repeat this step thrice to ensure efficient nutrient removal.  213 
 214 
3.2.3. After the last ME wash, resuspend cells in 1 mL of ME and add it to a 50 mL flask containing 215 
9 mL ME. Incubate for 12-16 h at 22-25 °C on minimal rotation speed (50-100 RPM). Abundant 216 
cell flocculation, which results in many round fission yeast clumps and indicates efficient mating.  217 
 218 
3.2.4. Take 1 mL sample of the mating culture and centrifuge at 1,375 x g for 1 min. Eliminate the 219 
supernatant but leave 250 µL in the tube to resuspend cells. Before placing cells on agarose pads, 220 



   

 
 

vortex vigorously for 5 s to disrupt clumps. 221 
 222 
NOTE: The remaining 250 µL ME used to resuspend cells contains mating factors that help cells 223 
enter meiosis.  224 
 225 
3.2.5. Place 20 µL of either a mitotic or meiotic cell suspension on a 2% agarose pad. Remove any 226 
excess medium by inverting the slide and putting it on the top of a lint-free paper towel for 2-3 s 227 
(Figure 1D). Set the slide pad-side up and gently place a glass coverslip, ensuring not to generate 228 
air bubbles (Figure 1F).  229 
 230 
NOTE: Eliminating excess medium with a paper towel is more time-efficient than gravity 231 
absorption, which is particularly critical in meiosis experiments.  232 
 233 
3.2.6. To create a cell monolayer, rotate the coverslip clockwise with the index finger for one 234 
(mitosis) or two (meiosis) full turns (Figure 1F). Ensure that the cell matter disperses across the 235 
agarose pad allowing for the better separation of single cells or asci. With the aid of a small 236 
wooden stick, dispense molten sealant along the edges of the coverslip to seal each agarose pad 237 
(Figure 1G). 238 
 239 
3.2.7. Once the agarose pad is sealed, place it on the microscope stage and let it equilibrate for 240 
10-15 min at the appropriate imaging conditions (e.g., temperature) (Figure 1H) to allow air 241 
bubbles to dissipate and let any last-minute agarose shifts to occur. Begin imaging once the slide 242 
is efficiently equilibrated and do not remove it from the stage until data collection ends.  243 
 244 
NOTE: Control of temperature and humidity is determined by the microscope system employed 245 
and specific experimental requirements. If present, apply the temperature and humidity control 246 
to all imaging experiments. If absent, researchers must devise a way to prevent temperature 247 
fluctuations, especially during meiosis experiments.  248 
 249 
4. Live-cell imaging2 and processing 250 
 251 
4.1. Use the 40x objective to find appropriate fields of view to the image. Switch to the 60x 252 
objective to begin data acquisition. Depending on the microscope system used, subsequent 253 
refocusing and sectioning on the sample at each time point will occur manually or through a 254 
microscope- or software-automated process.  255 
 256 
NOTE: The images presented in this protocol were collected using a deconvolution, fluorescence 257 
microscope equipped with Sedat, RFP and GFP filter sets, nano-motion stage, 60x NA 1.4 258 
objective lens, and 12-bit CCD camera. Built-in mechanical shutters and motorized filter wheels 259 
allowed for the reduced excitation exposure and photobleaching of samples. 260 
 261 
4.2. Use appropriate software to acquire and process images. To deconvolve images, employ 262 
manufacturer-provided optical transfer functions.  263 
 264 



   

 
 

NOTE: For details on the microscope equipment and software used in this protocol, refer to the 265 
Table of Materials.  266 
 267 
4.3. To use a conventional fluorescence microscope to acquire live-cell images ensure that the 268 
microscope collects data digitally, has 40x or 60x objectives with numerical apertures (NA) 269 
greater than 1.2, and is able to perform optical sectioning.  270 
 271 
NOTE: Without these requirements, images will show reduced resolution, compromising the 272 
quality of microscopic measurements and qualitative observations.  273 
 274 
4.4. Use free plug-in programs (e.g., Fiji) to minimize systematic blur errors arising from the 275 
contrast loss during the image acquisition17-20 and to ensure proper quantitative analysis of the 276 
fluorescence intensity and of other temporal and dynamic events within the cell.  277 
 278 
NOTE: Other available commercial deconvolution programs can be found in the Table of 279 
Materials.  280 
 281 
4.5. Choose the microscope filter sets that best match the fluorophores under observation. 282 
Ensure that the excitation and emission filters have the right band passes that allow for the 283 
specific detection of fluorescent proteins. For example, to detect CFP signal, an excitation and 284 
emission band pass of 430/25 and 470/30 is appropriate, but not for RFP fluorescence.  285 
 286 
4.6. Use a minimal-effective-settings approach (MESA) when imaging fission yeast at multiple 287 
time points. In other words, avoid prolonged use of excitation wavelengths and employ the 288 
lowest excitation power and exposure time that generate acceptable, yet quantifiable and 289 
reproducible imaging data.  290 
 291 
4.7. For prolonged imaging during mitosis or meiosis, limit the interval between acquisition time 292 
points to 5-10 min. Although 2% agarose pads can withstand 12 to 16 h imaging sessions, cell-293 
shifting due to agarose evaporation is likely. Therefore, perform full mitosis or meiosis 294 
experiments in 4-6 h or 8-10 h windows, respectively.  295 
 296 
4.8. Collect imaging data for 4-8 h consisting of at least 24-48 acquisition time points, 297 
respectively, one fluorescence protein, and a z-stack per time point and fluorescent channel 298 
comprised of 13 sections with 0.5-µm spacing using a 60x objective. This requires at least 0.5-1 299 
GB of hard drive storage space. Thus, besides eliminating photobleaching and cell-shifting, create 300 
a workflow that considers computing capabilities1-3.  301 
 302 
NOTE: These acquisition parameters are typically set and modified in the software that controls 303 
microscope functions and which collects and processes images.  304 
 305 
4.9. To examine specific nuclear processes in closer detail, perform image acquisition every 5-10 306 
s, as long as the emission does not decrease substantially after frequent exposure. Carry out a 307 
preliminary fluorescence intensity analysis over different time periods to determine the point 308 



   

 
 

after which the accuracy of the collected data is no longer reliable1,3.  309 
 310 
4.10. In the image-acquisition and image-processing software, use maximum intensity projection 311 
on the image z-stacks to observe all structures with high fluorescence density on a 2D plane 312 
regardless of their vertical location1-3. This facilitates a rapid examination of nuclear processes 313 
occurring in different voxels. Collect a mid-focal bright-field image to generate a reference 314 
picture of the cells under observation.  315 
 316 
5. Image analysis20,21  317 
 318 
NOTE: Image analysis in this protocol is performed using Fiji. For other analysis programs and Fiji 319 
plug-ins see Table of Materials.  320 
 321 
5.1. Upload a deconvolved image by selecting the Bio-Formats Importer feature under the 322 
Plugins menu. In the Import Options pop-up window, select Hyperstack, Default color mode, 323 
and check Autoscale before pressing the OK button.  324 
 325 
5.2. Ensure the displayed window has the correct number of fluorescence channels and time 326 
frames by scrolling sideways on the respective bars at the bottom. Save as a Tiff file, which does 327 
not compress data and prevents information loss.  328 
 329 
5.3. Open an image that contains a scale bar generated during data processing by the microscope 330 
software. Determine the pixel length of the scale bar using the Straight Line tool to draw a 331 
parallel line of similar size and select Measure from the Analyze menu. Add a scale bar by setting 332 
the image pixel-to-µm ratio by selecting Set Scale from the Analyze menu.  333 
 334 
5.3.1. In the Set Scale pop-up window, enter the calculated Distance in pixels and Known 335 
distance in µm, set Pixel aspect ratio to 1.0, put micron as the Unit of length, and check the 336 
Global box before clicking the OK button.  337 
 338 
5.4. Use the Set Measurements option under the Analyze menu to choose different parameters 339 
to quantify when selecting Measure. For the purposes of this protocol, select the following 340 
metrics: Area, Perimeter, Mean gray value, Median, Min & max gray value, Integrated density, 341 
Stack position, and Display label.  342 
 343 
5.5. Depending on the precision of the collected data, enter more than 1 for the Decimal places 344 
option and check the Scientific notation box if necessary. After applying the Measure command, 345 
a Results pop-up window will show the values for each pertinent parameter. Save the results as 346 
a .csv file for future analysis in a statistics program.  347 
 348 
NOTE: It is not necessary to separate an image into its constituent fluorescent channels for 349 
determining the length, unless there is signal interference among the different colors in which 350 
case follow the step detailed below.  351 
 352 



   

 
 

5.6. In the case of signal interference, select Color and Channels Tool from the Image menu and 353 
analyze each color separately. To measure the length of non-linear structures, right-click on the 354 
Line Tool and use the Segmented Line or Freehand Line option to trace the desired objects.  355 
 356 
5.6.1. For linear structures or to determine the distance between two points, use the Straight 357 
Line feature and select Measure from the Analyze menu. Values for length in µm will be 358 
automatically added to the parameters previously selected under the Set Measurements option.  359 
 360 
5.7. For measuring changes in the signal size and fluorescence intensity, first create a region of 361 
interest (ROI) library, which increases quantification accuracy and facilitates speedy 362 
measurements across an image stack. Select Color and Channels Tool under the Image menu.  363 
 364 
5.8. In the Channels pop-up window, check the color channel for which intensity or area will be 365 
measured. Choose the Adjust and Threshold features under the Image menu. Check the Dark 366 
background box, select the Default method (unless otherwise required by the collected data), 367 
and pick Red to overlay the signals of interest.  368 
 369 
NOTE: Measurement of protein stability, movement, and localization are closely dependent on 370 
the color threshold used for creating ROI libraries. It is important to choose the correct 371 
thresholding method for the type of fluorescent marker signal to be visualized17,18. 372 
 373 
5.9. Use the Wand tool to highlight each structure of interest and press the letter T on the 374 
keyboard to add the selected ROI to the pop-up ROI manager window. Repeat this process for 375 
each slice (time frame) in the image stack and store all ROIs by clicking on the More button and 376 
selecting Save.  377 
 378 
5.10. Open the zipped ROI folder to load the ROI manager and click on each ROI identifier on the 379 
left side panel. Select Measure from the Analyze menu and repeat this command on each ROI 380 
identifier to quantify the objects of interest in all slices of the image stack.  381 
 382 
5.11. If cell shifting is not an issue and the focal plane remains the same for all slices of the stack, 383 
click on Multi measure in the ROI manager. In the pop-up window, select Measure all slices 384 
instead of One row per slice to iterate measurements across the image stack. Save results as a 385 
csv file and analyze measurements in a statistics program.  386 
 387 
5.12. For multiple nuclear signals comprising the structure of interest, press the Shift key while 388 
selecting objects with the Wand tool to create a single ROI. Alternatively, create an ROI of 389 
constant size with the Oval tool to encompass all the signals of interest.  390 
 391 
NOTE: This oval approach may be necessary to measure and describe the signal behavior over an 392 
area where fluorescence signal changes in size and intensity over time. Signal intensity, in this 393 
case, is the mean signal density over a given area.  394 
 395 
5.13. Qualitatively determine co-localization of two fluorescent signals by the change in color of 396 



   

 
 

the signal overlap region. However, as the co-localization zone narrows, it is more difficult to 397 
distinguish signal overlap. In this case, follow the steps detailed below.  398 
 399 
5.14. Using the Channels Tool, as described in step 5.6, draw a straight line over each signal in 400 
question, and select the Plot Profile command under the Analyze menu.  401 
 402 
5.14.1. Repeat this step for all colors in question using the same drawn line.  403 
 404 
5.14.2. In the Plot of sample pop-up window that appears after each profiling step, press the List 405 
button to call up a Plot Values window, and save the measurements for each signal as a csv file.  406 
 407 
5.14.3. In a statistics program, create a graph that plots the Gray Value for each signal against its 408 
corresponding location (in µm) along the drawn line. Lack of overlap among signal profile plots 409 
generally indicates the lack of co-localization. 410 
 411 
NOTE: Use the Plot Profile tool on projected images to examine signal co-localization. This is only 412 
reliable if such overlap is also observed through the image z-stack.  413 
 414 
5.15. To monitor the dynamic behavior of fluorescent proteins over time use the Multi 415 
Kymograph tool found under the Analyze menu. The resulting image shows the fluorescent 416 
signal movement through a series of condensed snapshots in each slice of the z-stack, which 417 
represents individual time points.  418 
 419 
5.15.1. Use the Channels Tool as described in step 5.6 to isolate the object of interest in the 420 
correct channel. Make sure the selected object or structure does not shift considerably through 421 
the z-stack. Place a straight line or rectangle over the object, select the Multi Kymograph tool 422 
from the Analyze menu, and enter the desired width of the line overlaying the object. 423 
 424 
5.16. Create image panels that show nuclear dynamics over a specific time window using the 425 
Channels Tool as described in step 5.6 and by selecting the Stacks and Make Montage tools from 426 
the Image menu. In the Make Montage pop-up window, enter the number of Columns and Rows 427 
desired, set a Scale Factor of 1.0, choose the First and Last slices (time frames), and change 428 
Border width to at least 5 before pressing OK. It is possible to choose which images in the stack 429 
to show by changing Increments to suit the desired sequence.  430 
 431 
5.16.1. To generate a movie, upload the desired hyperstack, select Save as an avi file from the 432 
File menu, choose none for Compression, and enter a Frame rate of 2-8 fps. Select the Make 433 
Montage command while picking Composite in the Channels Tool to merge or separate all colors 434 
comprising the image.  435 
 436 
NOTE: Two avi files (Movie 1-2) are provided in this protocol. Use them in Fiji to try different 437 
features highlighted throughout step 5.  438 
 439 
5.16.2. To show a single, representative cell, use Transform and Rotate from the Image menu 440 



   

 
 

and enter degrees of rotation. Negative numbers rotate objects to the left, while positive values 441 
rotate objects to the right. Once the cell is in the proper orientation, draw a rectangle that 442 
encompasses the entire cell through the z-stack or during the time frames of interest and select 443 
Crop from the Image menu. Proceed as mentioned in step 5.16 and 5.16.1 to generate an image 444 
panel or movie.  445 
 446 
5.17. Add a scale bar to the image panel or movie by selecting Tools and Scale bar from the 447 
Analyze menu. In the Scale Bar pop-up window, enter 5-15 for Width in microns for single cells 448 
or 100-250 for entire fields of view, choose white or black for Color, and pick an appropriate 449 
Location to place the scale bar.  450 
 451 
5.17.1. For movies, it is useful to show time progression during nuclear events. To show time 452 
change between frames, select Image, click on Stacks, use the Time Stamper tool, indicate the 453 
start frame in the time series, and select an appropriate location for the time display.  454 
 455 
REPRESENTATIVE RESULTS: 456 
Whether live-cell imaging is used for mitosis or meiosis, it is crucial to employ healthy fission 457 
yeast cells before making any type of observation. The quality of the resulting data relies heavily 458 
on the starting material. If cells starve due to nutrient limitation or overgrowth, they will show 459 
excess vacuoles and decreased cell size (Starvation, Figure 2A). For mitosis experiments, it is best 460 
to avoid using cells that show cellular stress (Starvation, Figure 2A). Otherwise, experimental 461 
results will be inconsistent and irreproducible. To circumvent this limitation, choose proper wild 462 
type controls and become familiar with the various phenotypes of mutants of interest. For 463 
example, mitotic cells starved for 12 h cease to actively replicate DNA. Since Tos4-GFP expression 464 
is associated with G1/S-phase activity22,23, logarithmic cells carrying this marker and one for 465 
nuclear division (Sad1-DsRed10) show pan-nuclear Tos4-GFP expression, Sad1-DsRed foci 466 
separation, and ongoing septation (suggesting active DNA replication and cell division) (Log, 467 
Figure 2A), while starved cells show no such activity (Starvation, Figure 2A). This result is 468 
consistent with the effects of nutrient limitation in fission yeast, which decreases transcription in 469 
G1, activates the G1/S cell cycle checkpoint, and promotes G0 entry5. For meiosis experiments, 470 
cells must grow to a high density, but without reaching the stationary phase. Afterward, cells of 471 
both mate types are mixed and incubated together in low nitrogen media. Failure to mate, as is 472 
the case when cells are not sufficiently starved of nitrogen, will prevent them from entering 473 
meiosis (Inefficient, Figure 2B). Robust flocculation of the mating cell suspension increases cell-474 
to-cell interaction and thus indicates successful mating and efficient meiotic induction (Efficient, 475 
Figure 2B).  476 
 477 
Agarose gel pads and physical disruption of cell clumps guarantee proper visualization of single 478 
cells or asci (Log, Figure 2A; Efficient, Figure 2B). Pads must provide a rigid, yet moist platform 479 
on which cells are simultaneously fixed in place and protected from desiccation. In addition, pads 480 
must be thick enough to withstand changes due to evaporation and provide a leveled surface 481 
that permits proper focus throughout image acquisition (Figure 1C). Coverslip rotation is 482 
necessary to separate and spread cells within mating aggregates (Figure 1F; Efficient, Figure 2B). 483 
Without this step, few asci but numerous haploid cells are observed because asci become 484 



   

 
 

trapped within inaccessible layers of mating clumps, while haploid cells are free to populate all 485 
available monolayer spots (Figure 2B). Even for mitotic experiments, where cell clumping is less 486 
problematic, coverslip rotation moves cells around the pad to create a single cell layer with 487 
sufficient space between cells to reduce crowding effects and allow for cell duplication (Log, 488 
Figure 2A). 489 
 490 
Atb2 is an α-tubulin component involved in chromosome segregation in fission yeast mitosis and 491 
meiosis7,14. When fluorescently tagged, this cytoskeleton component allows for examination of 492 
the stages that characterize nuclear separation in mitosis. During prophase (0’-20’, Figure 3A), 493 
nucleation of the mitotic spindle occurs in the nuclear side of the spindle pole bodies (SPBs), as 494 
revealed by Atb2-mRFP fibers set against an Htt1-GFP5 pan-nuclear background. During the 495 
metaphase-anaphase transition (20’-40’, Figure 3A) the mitotic spindle extends outward and the 496 
nucleus splits in two. As the cell enters telophase (60’-80’, Figure 3A), Atb2-mRFP expands 497 
bidirectionally until chromosomes are entirely separated. After this point, Atb2-mRFP fibers 498 
regroup and spread across the cell surface to regain their interphase form in each of the resulting 499 
daughter cells. Cytokinesis (>120’, Figure 3A) occurs only after a septum forms and divides the 500 
cell by fission. Following changes in Hht1-GFP intensity over a mitotic cycle reveals three 501 
important steps in nuclear dynamics: metaphase-anaphase (medium intensity, DNA compaction: 502 
20’-40’, Figure 3A-B), telophase (low intensity, DNA separation: 60’-80’, Figure 3A-B), and G1 503 
(increasing intensity, DNA duplication: 100’-120’, Figure 3A-B). Similarly, but using cells that only 504 
carry Hht1-mRFP and employing the multi-kymograph tool (see step 5.15) in Fiji, it is possible to 505 
observe mitotic division from metaphase to telophase and evaluate the nuclear movements 506 
involved during proper sister chromatid segregation (Normal, Figure 3C). Mis-segregation 507 
kymographs show signal activity between the two main nuclear paths, indicating possible mis-508 
segregation due to chromosome fragmentation or inappropriate chromatid separation (Lagging, 509 
Figure 3C).   510 
 511 
As mentioned previously, in budding and fission yeast, Tos4 is transcribed in G1 and functions 512 
during DNA replication in S phase22,23. This can be observed in a kymograph where Tos4-GFP 513 
expression increases in the nucleus after Sad1-DsRed10 foci move to opposite directions 514 
(indicating nuclear division), but before the septum forms, which precedes cytokinesis (39’, 515 
Figure 3D; 36’, Figure 3E). The phase of high Tos4-GFP activity begins at the end of the M-G1/S 516 
transition (45’, Figure 3E) and ends in G2 (>60’, Figure 3E), right after the cell division. While 517 
greatly diffused during G1, Tos4-GFP signal intensity increases post anaphase and throughout S-518 
phase and co-localizes with segregated Sad1-DsRed foci (45’-60’, Figure 3E). This result reveals 519 
the septation period in fission yeast when genome duplication has begun in daughter cells (G1/S), 520 
but cytokinesis has not occurred yet. 521 
 522 
Hht1 is histone H3 in fission yeast and is commonly modified with fluorescent tags to visualize 523 
nuclear DNA5,14. In mitosis, as cells transition from metaphase to telophase (20’-120’, Figure 3A), 524 
two distinguishable changes to nuclear mass are observed. The first change involves a contraction 525 
of nuclear size in metaphase (20’, Figure 3A), while the second shows nucleus splitting during 526 
anaphase (40’, Figure 3A). Besides sharing these changes with mitotic cells, meiotic cells exhibit 527 
nuclear oscillation (i.e., horse-tailing) (-100’ to -50’, Figure 4A-B) during homologous 528 



   

 
 

recombination and further reduction of nucleus size at the end of anaphase II (70’-90’, Figure 529 
4A). Hht1-mRFP is used to examine mis-segregation phenotypes such as lagging or fragmented 530 
chromosomes (Lagging, Figure 3C). It is also employed to observe and describe the nuclear 531 
dynamics in each of the phases of meiosis (Figure 4A-B). Nuclear mass is large and fluctuates in 532 
size during much of horse-tailing (HT: -100’ to -50’, Figure 4A-B)). As cells enter metaphase (MT: 533 
-40’ to 0’, Figure 4A-B), nuclear size and oscillation decrease, consistent with increased 534 
condensation activity at this stage. The onset of both anaphase I (MI: 10’-60’, Figure 4A-B) and II 535 
(MII: 70’-90’, Figure 4A-B) is associated with further nuclear reduction and lack of nuclear 536 
movement, which correlates well with the two nuclear divisions that characterize meiosis I and 537 
II (MI & MII). Thus, meiosis is associated with nuclear size fluctuations when homologous 538 
chromosomes align and recombine and with nuclear size reductions following two rounds of 539 
chromosome separation. Alleles that change these nuclear dynamics are likely associated with 540 
genome stability regulation in meiosis12,13.        541 
 542 
Rec8 is the α-kleisin subunit of meiotic cohesin in fission yeast. It is loaded onto the chromatin 543 
after DNA replication (mei-S) and keeps sister chromatids tethered to each other until anaphase 544 
II. After metaphase I, Rec8 is removed from chromosome arms by separase and is protected at 545 
the centromere by Sgo1-PP2A. At the end of homolog segregation, Rec8 is also eliminated at the 546 
centromere, thereby allowing for sister chromatid separation (Figure 5A)6,24. Rec8-GFP along 547 
with markers of chromosome segregation such as Sad1-DsRed or Hht1-mRFP allow for the 548 
visualization of cohesion dynamics during meiosis. Rec8-GFP signal is pan-nuclear during mei-S 549 
(<<-90’, Figure 5A-B), prophase I (-90’ to -50’, Figure 5A-B), and metaphase I (-40’ to 0’, Figure 550 
5A-B). This observation reveals the association of Rec8-GFP along chromosomes axes that follows 551 
DNA duplication. As cells enter anaphase I (10’, Figure 5A-B), Rec8-GFP intensity decreases 552 
throughout the nucleus but remains strong at the centromere, where it forms a focus in each 553 
nuclear mass (20’-70’, Figure 5A-B). This result is consistent with Rec8-GFP degradation along 554 
chromosome arms but not at the centromere, that ensues after homolog segregation. Before 555 
anaphase II, the Rec8 focus disappears, freeing sister chromatids for separation in MII (70’-80’, 556 
Figure 5A-B). The Rec8-GFP marker is, thus, useful to examine conditions that disrupt the 557 
establishment, removal, and overall stability of meiotic cohesion. Paired with a marker of nuclear 558 
division such as Hht1-mRFP5,13, Rec8-GFP can be employed to address questions of how cohesion 559 
timing and stability prior to and during meiosis affect proper chromosome segregation12,13. This 560 
protocol does not address proteins whose dynamics occur primarily in the cytosol. However, 561 
Table I shows a few cytosolic proteins that are commonly used to examine cytoskeleton and 562 
membrane processes necessary for endocytosis, exocytosis, and cytokinesis among other 563 
processes.  564 
 565 
FIGURE AND TABLE LEGENDS:  566 
Figure 1: Preparation of agarose pads for live-cell imaging. (A) Slide preparation set-up 567 
assembled using a pipette tip holder, lab tape, and microscope slides. Placing slides perpendicular 568 
to each other creates a pocket where the agarose pad forms. Addition of lab tape pieces at the 569 
sides adjusts the agarose pad width to the required specifications. (B) Molten agarose is let to 570 
cool down before setting it on microscope slides to make pads. In this step, it is necessary to 571 
dispense the agarose volume slowly to avoid creating air bubbles. (C) The top slide is placed on 572 



   

 
 

the dispensed agarose spot to form a circular pad with a straight surface, even edges, and no 573 
visible agarose cracks. (D) After putting a sample of cell suspension on the agarose pad, invert 574 
slide and place atop a lint-free paper towel to remove extra liquid medium. (E) Carefully place a 575 
coverslip on the agarose pad, making sure not to trap any air bubbles and checking that the focus 576 
plane is flat to avoid cell shifting and focusing issues. (F) Slowly and cautiously, rotate coverslip 577 
clockwise to disrupt cell clumps and to generate a cell monolayer that allows for cell expansion 578 
and better cell visualization. (G,H) Use a heated hydrocarbon mixture to seal agarose pads and 579 
allow them to equilibrate to the desired temperature before imaging.  580 
 581 
Figure 2: Picking the right cells. (A) Top panels show fission yeast cells left to starve in EMM plus 582 
supplements for 72 h and bottom panel shows cells undergoing logarithmic growth. In cells that 583 
are left to starve, small cell morphologies can be appreciated. The red open arrow shows vacuolar 584 
granules that are characteristic of starvation. In logarithmic cultures, cells showing elongated 585 
morphologies and septa (red arrow) abound, indicating active cycling dynamics. The right-side 586 
panels show cells expressing Tos4-GFP and Sad1-DsRed signals during starvation and 587 
proliferation. Pan-nuclear Tos4-GFP expression and Sad1-DsRed signals that localize to opposite 588 
cell poles are seen during active proliferation, but not in starvation. (B) Top panel shows cells of 589 
the same mate-type (h+) failing to mate efficiently. The red open arrow shows a pair of vacuolar 590 
cells undergoing karyogamy. This is not unusual in cultures of h+ cells, where 10% of cells can 591 
switch mate-type to h-. Bottom panel shows asci resulting from efficient mating. Zygotic asci take 592 
multiple forms including the zig-zag (red arrow) and banana cell shapes (red open arrow). Scale 593 
bar represents 5 µm in length.  594 
 595 
Figure 3: Mitotic nuclear dynamics. (A) Histone H3 (Hht1-GFP) and microtubule (Atb2-mRFP) 596 
proteins were followed during one mitosis cycle (120 min). Individual signals for Hht1-GFP and 597 
Atb2-mRFP are shown in black and white panels, while the BF merge shows them in their 598 
respective colors. (B) Quantification of Hht1-mGFP intensity over a mitotic cycle. The change in 599 
Hht1 levels is indicative of nuclear division during mitosis and DNA duplication in G1. (C) 600 
Kymographs showing normal or abnormal segregation in mitosis where the resulting nuclear 601 
paths either bifurcate and retain DNA integrity or deviate and promote chromosome 602 
fragmentation or premature chromatid separation, respectively. (D,E) Kymograph and 603 
micrograph panels showing the duration of M-to-G1/S revealed by the segregation of Sad1-604 
DsRed and appearance of nuclear Tos4-GFP signals. Note the middle panels in E which were 605 
generated using the FIRE LUT in Fiji to create an intensity-graduated thermal map that facilitates 606 
the identification of spots with high Tos4-GFP expression; in this case, localized to the nucleus 607 
and overlapping Sad1-DsRed signals, as expected. Scale bar represents 5 µm in length. 608 
 609 
Figure 4: Meiotic nuclear dynamics. (A) Panel series showing movement, compaction, and 610 
division of the nucleus (Hht1-mRFP) during meiosis. Horse-tailing (HT) shows extensive side-to-611 
side nuclear oscillations followed by Metaphase (MT), where nuclear lateral movement 612 
decreases and entirely halts right before anaphase I. In meiosis I (MI), the main nuclear mass 613 
splits into two, while in meiosis II (MII) four nuclei are generated during the process of sister 614 
chromatid separation. (B) Quantification of nuclear area change (Hht1-mRFP) in prophase, 615 
metaphase, MI & MII. Nuclear area is dynamic during HT oscillations, becomes condensed in MT, 616 



   

 
 

and further decreases in size during MI & MII, where little nuclear movement is observed (Long 617 
Nuclear Axis). Measuring the longest nuclear axis (Long Nuclear Axis) is based on the idea that as 618 
a circle stretches, it ceases to have a constant diameter and generates at least two main axes: 619 
long and short. Thus, when monitoring changes in the nucleus, changes in either the long or short 620 
axis provide indications of nuclear movement. Scale bar represents 5 µm in length. 621 
 622 
Figure 5: Meiotic cohesin dynamics. (A) Panel series showing how Rec8-GFP signal change 623 
correlates with meiotic nuclear dynamics. During HT and MT, Rec8-GFP signal is pan-nuclear and 624 
follows nuclear movement (Hht1-mFRP). In MI, Rec8-GFP dissipates from the nucleus, leaving 625 
only a pair of foci, which is consistent with Rec8 removal from chromosome arms and 626 
establishment of Sgo1-PP2A protection at the centromere. As the cell approaches MII, Rec8-GFP 627 
foci begin to disappear and are no longer seen right before anaphase II. (B) Quantification of 628 
Rec8-GFP intensity from HT to MII. Similar to what is seen in A, GFP signal is high through HT and 629 
MT, substantially decreases during MI and completely disappear in MII. This pattern corroborates 630 
cohesin dynamics at chromosome arms and the centromere, where it keeps sister chromatids 631 
tethered until ready to be separated in MII. Scale bar represents 5 µm in length. 632 
 633 
Table 1: Markers of nuclear and cytosolic dynamics. 634 
 635 
Movie 1: M-to-G1/S transition showing spindle pole body (SPB; Sad1-DsRed) separation 636 
preceding septation and accumulation of Tos4-GFP nuclear signal.  637 
 638 
Movie 2: Completion of the mitotic cycle showing the microtubule (Atb2-mRFP) extension 639 
correlating with nuclear (Hht1-GFP) division.  640 
 641 
DISCUSSION:  642 
Live-cell imaging during mitosis and meiosis offers the opportunity to examine nuclear dynamics 643 
without substantially disrupting fission yeast physiology during data acquisition. However, 644 
caution must be exercised to ensure cells grow to the desired densities free of environmental 645 
stresses; and for meiosis, that the cells are imaged during the time of terminal differentiation and 646 
not too early or late. Excess cellular crowding, starvation, and inappropriate growth 647 
temperatures are common factors that contribute to irreproducible observations. In addition, 648 
during strain construction, it is crucial to test that fluorescent tags do not interfere with the 649 
functions of target genes nor impact overall cell fitness. Failure to closely inspect the phenotypes 650 
of strains carrying fluorescent markers may result in inconsistent and incomparable results across 651 
similar genotypes.  652 
 653 
Though microscope agarose pads are simple to assemble, they can also pose a hurdle in obtaining 654 
valuable imaging data. Creating agarose pads is as simple as placing three microscope slides 655 
parallel to each other, dispensing molten agarose on the middle slide, and putting a slide that 656 
transverses the top of the other slides. It is useful, however, to assemble a slide-maker apparatus 657 
that allows for width modifications to manufacture resistant, situation-specific agarose pads. A 658 
simple slide-maker that gives pad width flexibility consists of a platform (pipette tips holder or 659 
the bench), two microscope slides, and lab tape acting as the pad-width adjusting mechanism 660 



   

 
 

(Figure 1A). Exact pad thickness will depend on imaging time requirements, agarose brand, 661 
temperature, coverslip sealant, evaporation rate, etc. Thus, it is important to calibrate the 662 
imaging system before data acquisition to increase technical reproducibility and to enhance the 663 
quality of live-cell imaging1-3. Pad surface, rigidity, and composition are essential during 664 
prolonged image acquisition. Agarose has low background fluorescence, can be easily molded, 665 
and at the appropriate concentration, withstands structural deformation due to evaporation. 666 
Moreover, combining fission yeast media with agarose does not compromise image quality and 667 
allows for extended observation of multiple mitoses and meiosis cycles. Also, it is important to 668 
avoid any air bubbles for time-lapse microscopy. Inside agarose pads and within the sample, air 669 
pockets expand over time, causing cell-shifting and disrupting focal planes. Provided cells are 670 
efficiently spread apart by coverslip rotation, researchers can follow mitotic processes across 671 
several generations and meiotic events from nuclear fusion to sporulation. Making and choosing 672 
the right pad for imaging experiments takes time to master, but once achieved, can contribute 673 
to highly informative microscope observations.  674 
 675 
As is the case with other methods, live-cell microscopy is not free of technical limitations. The 676 
use of fluorescently-tagged proteins introduces boundaries to experiments that limit the scope 677 
of what can be studied. Photo-bleaching and photo-toxicity are problems typical of prolonged 678 
image acquisition. They can be counteracted by not exposing cells to short wavelengths for too 679 
long or too frequently. For experiments involving GFP, CFP, YFP, mRFP, and DsRed, typical 680 
fluorescent proteins used in fission yeast live-cell imaging, it is common to employ 5-15% 681 
excitation light and 100-500 ms exposure time for routine experiments. These parameters 682 
change, however, according to the specific experiment requirements of the researcher. In 683 
addition, z-stacks comprised of 9-13 sections with 0.5 µm spacing using a 60x objective is enough 684 
to resolve the thickness of a fission yeast cell. Moreover, it is important to confirm that 685 
fluorescent markers do not disrupt proper regulation or function of target proteins or generate 686 
spurious phenotypes. Thus, it is advisable to construct strains containing different fluorescent 687 
and affinity tags for the same target gene to corroborate observations by different means. 688 
Furthermore, it is the responsibility of researchers to ensure that experimental parameters can 689 
be reproduced across experiments and that the collected data is fit for downstream analysis1,3. 690 
No technology can replace the time-tested practice of meticulously validating experimental 691 
systems by careful observation and rigorous examination of linearity in detecting fluorescent 692 
signals.  693 
 694 
Finally, it is crucial to analyze microscopy data in formats that do not modify raw images. Fiji 695 
provides excellent documentation tools to keep track of raw data measurements and allows 696 
researchers to examine different cell parameters in a single session. These features, as well as its 697 
wealth of online tutorials and extensive literature coverage, make Fiji an important tool for 698 
measuring, analyzing, and presenting live cell imaging data that describe the nuclear dynamics of 699 
fission yeast in mitosis and meiosis.   700 
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Table I. Markers of nuclear and cytosolic dynamics

Protein Function Comments Tag References

Hht1 Histone H3 involved in DNA packaging Used to examine chromosome dynamics Hht1-mRFP 5,14

Tos4 Tos4 function occurs during G1 phase Employed to study G1 timing Tos4-GFP 22,23

Cnp1 Histone H3 CENP-A localizes specifically at 

the centromere

Used to follow chromosome segregation dynamics in 

mitosis and meiosis 

Cnp1-mCherry 13

5,13

13

10

25

25

5

26

27

28

Formin involved in actin fusion focus 

assembly during cytogamy

Used to study fusion dynamics associated with fission 

yeast mating

Fus1-sfGFP

Mannolsyltransferase subunit involved in 

protein N-linked glycosylation in the Golgi 

apparatus

Mnn9

Fus1

Employed to study cargo maturation in the Golgi as it 

progresses from cis -Golgi to trans -Golgi 

Mnn9-mCherry

Ccr1N-GFP

Rho guanyl-nucleotide exchange factor 

involved in the establishment and 

maintenance of cell polarity

Gef1 Used to examine global, microtubule-dependent cell 

polarity dynamics

Myosin II subunit involved in contractile 

ring contraction

NADPH-cytochrome p450 reductase that is 

part of the ER, plasma, and mitochrondrial 

outer membrane

Gef1-mCherry-GBP

Ccr1 Employed to examine membrane-associated dynamics 

such as endocytosis, exocytosis, and cytokinesis 

Exocytosis and endocytosis regulator 

involved in vesicle-mediated transport

Ync13 Employed to study cell-wall integrity during 

cytokinesis

Ync13-mECitrine

Used to explore the dynamics of septum maturation 

and contraction

RIc1-mCherryRlc1

Swi6

Sad1

CYTOSOL & MEMBRANE
Tubulin alpha 2 involved in microtubule 

cytoskeleton organization

Atb2 Used to examine chromosome segregation in mitosis 

and meiosis

Sad1 is involved in localizing the spindle 

pole body to the nuclear envelope

Employed to analyze chromosome segregation in 

mitosis and meiosis

HP1 homologue protein involved in 

heterochromatin formation

Employed to study heterochromatin mobilization at 

the centromere and telomeres 

Swi6-GFP

Sad1-mCherry

Atb2-mRFP 7,14

Rad52

Rad21-GFP/Rec8-GFP

Rad11-YFP

Rad52 acivity takes place during mitotic 

DNA repair and meiotic recombination

Employed to study DNA repair in mitosis and 

recombination dynamics in meiosis

Rad52-CFP

NUCLEUS

Cohesin subunits involved in keeping sister 

chromatids together following replication
RPA activity occurs during mitotic DNA 

repair, meiotic recombination, and ends in 

metaphase

Employed to study DNA repair in mitosis and 

recombination dynamics in meiosis

Rad11

Rad21/ 

Rec8

Used to analyze cohesion stability during mitotic 

(Rad21) and meiotic segregation (Rec8)

6,24

5,13
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29

28

Used to examine mitochondria-dependent dynein 

anchoring during nuclear oscillation in meiotic 

prophase I

Cortical anchoring factor for dynein 

involved in horse-tailing

Num1 Num1-yEGFP

Mannolsyltransferase subunit involved in 

protein N-linked glycosylation in the Golgi 

apparatus

Mnn9 Employed to study cargo maturation in the Golgi as it 

progresses from cis -Golgi to trans -Golgi 

Mnn9-mCherry



Name of Material/Equipment Company Catalog Number

60x Plan Apochromat objective lens Olympus AMEP4694

Adenine Sigma A-8751

Agar 7558B IB4917-10 kg

Agarose Sigma A9539-500g

Belly Dancer rotator Stovall US Patent #4.702.610

Biotin Sigma B-4501

Boric acid Sigma B-6768-5kg

CaCl2·2H20, Sigma C3306-500G

Citric acid Sigma C-0759

Convolve 3D software plug-in OptiNav, Inc. n/a

CoolSnap HQ CCD camera Roper n/a

Cover slip VWR 16004-302

CuSO4·5H20, END CX-2185-1

DeltaVision deconvolution 

fluorescence microscope

GE 

Healthcare/Applied 

Precision

n/a

Diffraction PSF 3D software plug-in OptiNav, Inc. n/a

Edinburgh minimal medium (EMM) 

Notrogen Sunrise 2023;1kg

FeCl2·6H2O END FX9259-04

Glucose Sigma G-7021

Heat plate Barnstead Thermo Lyne

Histidine Sigma H8125-100g

Huygens deconvolution software SVI n/a

Imaris deconvolution software Bitplane n/a

Incubator Shell lab #3015

Inositol Sigma I-5125

Iterative Deconvolve 3D software plug-

in OptiNav, Inc. n/a

KCl Mallinckvadt 6858-04

Lanolin Sigma L7387-1kg

Leucine Sigma L8912-100g

Lysine Sigma L5626-500g

Malt extract (ME) MP 4103-032

MgCl2·6H20 AMRESCO 0288-500G

MetaMorph Molecular Devices n/a

Microscope slides VWR 16004-422

MnSO4, Mallinckvadt 6192-02

Molybdic acid Sigma M-0878

Na2S04 Mallinckvadt 8024-03

Nicotinic acid, Sigma N-4126

Pantothenic acid Sigma P-5161

Paraffin wax Fisher s80119WX

Pombe glutamate medium (PMG) Sunrise 2060-250
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softWorx v3.3 image processing 

software GE Healthcare n/a

Sporulation Medium powder Sunrise 1821-500

Temperature controlled centrifuge Beckman Allwgra 6KR xentrifuge

Uracil AMRESCO 0847-500g

Vaseline Equaline F79658

yeast extract EMD 1.03753.0500

Yeast extract plus supplements (YES) Sunrise 2011-1kg

ZnSO4·7H2O J.T.Baker 4382-04
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Title of Article:  

 

Author(s):  

 

 

Item 1: The Author elects to have the Materials be made available (as described at 

http://www.jove.com/publish) via: 

� Standard Access  � Open Access

 

Item 2: Please select one of the following items: 

� The Author is NOT a United States government employee. 

� The Author is a United States government employee and the Materials were prepared in the 

course of his or her duties as a United States government employee. 

� The Author is a United States government employee but the Materials were NOT prepared in the 

course of his or her duties as a United States government employee. 

 

ARTICLE AND VIDEO LICENSE AGREEMENT 
 

1. Defined Terms. As used in this Article and Video 

License Agreement, the following terms shall have the 

following meanings: “Agreement” means this Article and 

Video License Agreement; “Article” means the article 

specified on the last page of this Agreement, including any 

associated materials such as texts, figures, tables, artwork, 

abstracts, or summaries contained therein; “Author” 

means the author who is a signatory to this Agreement; 

“Collective Work” means a work, such as a periodical issue, 

anthology or encyclopedia, in which the Materials in their 

entirety in unmodified form, along with a number of other 

contributions, constituting separate and independent 

works in themselves, are assembled into a collective whole; 

“CRC License” means the Creative Commons Attribution-

Non Commercial-No Derivs 3.0 Unported Agreement, the 

terms and conditions of which can be found at: 

http://creativecommons.org/licenses/by-nc-

nd/3.0/legalcode; “Derivative Work” means a work based 

upon the Materials or upon the Materials and other pre-

existing works, such as a translation, musical arrangement, 

dramatization, fictionalization, motion picture version, 

sound recording, art reproduction, abridgment, 

condensation, or any other form in which the Materials may 

be recast, transformed, or adapted; “Institution” means 

the institution, listed on the last page of this Agreement, by 

which the Author was employed at the time of the creation 

of the Materials; “JoVE” means MyJove Corporation, a 

Massachusetts corporation and the publisher of The Journal 

of Visualized Experiments; “Materials” means the Article 

and / or the Video; “Parties” means the Author and JoVE; 

“Video” means any video(s) made by the Author, alone or 

in conjunction with any other parties, or by JoVE or its 

affiliates or agents, individually or in collaboration with the 

Author or any other parties, incorporating all or any portion 

of the Article, and in which the Author may or may not 

appear. 

2. Background. The Author, who is the author of the 

Article, in order to ensure the dissemination and protection 

of the Article, desires to have the JoVE publish the Article 

and create and transmit videos based on the Article. In 

furtherance of such goals, the Parties desire to memorialize 

in this Agreement the respective rights of each Party in and 

to the Article and the Video. 

3. Grant of Rights in Article. In consideration of JoVE 

agreeing to publish the Article, the Author hereby grants to 

JoVE, subject to Sections 4 and 7 below, the exclusive, 

royalty-free, perpetual (for the full term of copyright in the 

Article, including any extensions thereto) license (a) to 

publish, reproduce, distribute, display and store the Article 

in all forms, formats and media whether now known or 

hereafter developed (including without limitation in print, 

digital and electronic form) throughout the world, (b) to 

translate the Article into other languages, create 

adaptations, summaries or extracts of the Article or other 

Derivative Works (including, without limitation, the Video) 

or Collective Works based on all or any portion of the Article 

and exercise all of the rights set forth in (a) above in such 

translations, adaptations, summaries, extracts, Derivative 

Works or Collective Works and(c) to license others to do any 

or all of the above. The foregoing rights may be exercised in 

all media and formats, whether now known or hereafter 

devised, and include the right to make such modifications 

as are technically necessary to exercise the rights in other 

media and formats. If the “Open Access” box has been 

checked in Item 1 above, JoVE and the Author hereby grant 

to the public all such rights in the Article as provided in, but 

subject to all limitations and requirements set forth in, the 

CRC License. 
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4. Retention of Rights in Article. Notwithstanding 

the exclusive license granted to JoVE in Section 3 above, the 

Author shall, with respect to the Article, retain the non-

exclusive right to use all or part of the Article for the non-

commercial purpose of giving lectures, presentations or 

teaching classes, and to post a copy of the Article on the 

Institution’s website or the Author’s personal website, in 

each case provided that a link to the Article on the JoVE 

website is provided and notice of JoVE’s copyright in the 

Article is included. All non-copyright intellectual property 

rights in and to the Article, such as patent rights, shall 

remain with the Author. 

5. Grant of Rights in Video – Standard Access. This 

Section 5 applies if the “Standard Access” box has been 

checked in Item 1 above or if no box has been checked in 

Item 1 above. In consideration of JoVE agreeing to produce, 

display or otherwise assist with the Video, the Author 

hereby acknowledges and agrees that, Subject to Section 7 

below, JoVE is and shall be the sole and exclusive owner of 

all rights of any nature, including, without limitation, all 

copyrights, in and to the Video. To the extent that, by law, 

the Author is deemed, now or at any time in the future, to 

have any rights of any nature in or to the Video, the Author 

hereby disclaims all such rights and transfers all such rights 

to JoVE. 

6. Grant of Rights in Video – Open Access. This 

Section 6 applies only if the “Open Access” box has been 

checked in Item 1 above. In consideration of JoVE agreeing 

to produce, display or otherwise assist with the Video, the 

Author hereby grants to JoVE, subject to Section 7 below, 

the exclusive, royalty-free, perpetual (for the full term of 

copyright in the Article, including any extensions thereto) 

license (a) to publish, reproduce, distribute, display and 

store the Video in all forms, formats and media whether 

now known or hereafter developed (including without 

limitation in print, digital and electronic form) throughout 

the world, (b) to translate the Video into other languages, 

create adaptations, summaries or extracts of the Video or 

other Derivative Works or Collective Works based on all or 

any portion of the Video and exercise all of the rights set 

forth in (a) above in such translations, adaptations, 

summaries, extracts, Derivative Works or Collective Works 

and (c) to license others to do any or all of the above. The 

foregoing rights may be exercised in all media and formats, 

whether now known or hereafter devised, and include the 

right to make such modifications as are technically 

necessary to exercise the rights in other media and formats. 

For any Video to which this Section 6 is applicable, JoVE and 

the Author hereby grant to the public all such rights in the 

Video as provided in, but subject to all limitations and 

requirements set forth in, the CRC License. 

7. Government Employees. If the Author is a United 

States government employee and the Article was prepared 

in the course of his or her duties as a United States 

government employee, as indicated in Item 2 above, and 

any of the licenses or grants granted by the Author 

hereunder exceed the scope of the 17 U.S.C. 403, then the 

rights granted hereunder shall be limited to the maximum 

rights permitted under such statute. In such case, all 

provisions contained herein that are not in conflict with 

such statute shall remain in full force and effect, and all 

provisions contained herein that do so conflict shall be 

deemed to be amended so as to provide to JoVE the 

maximum rights permissible within such statute. 

8. Protection of the Work. The Author(s) authorize 

JoVE to take steps in the Author(s) name and on their behalf 

if JoVE believes some third party could be infringing or 

might infringe the copyright of either the Author’s Article 

and/or Video. 

9. Likeness, Privacy, Personality. The Author hereby 

grants JoVE the right to use the Author’s name, voice, 

likeness, picture, photograph, image, biography and 

performance in any way, commercial or otherwise, in 

connection with the Materials and the sale, promotion and 

distribution thereof. The Author hereby waives any and all 

rights he or she may have, relating to his or her appearance 

in the Video or otherwise relating to the Materials, under 

all applicable privacy, likeness, personality or similar laws. 

10. Author Warranties. The Author represents and 

warrants that the Article is original, that it has not been 

published, that the copyright interest is owned by the 

Author (or, if more than one author is listed at the beginning 

of this Agreement, by such authors collectively) and has not 

been assigned, licensed, or otherwise transferred to any 

other party. The Author represents and warrants that the 

author(s) listed at the top of this Agreement are the only 

authors of the Materials. If more than one author is listed 

at the top of this Agreement and if any such author has not 

entered into a separate Article and Video License 

Agreement with JoVE relating to the Materials, the Author 

represents and warrants that the Author has been 

authorized by each of the other such authors to execute this 

Agreement on his or her behalf and to bind him or her with 

respect to the terms of this Agreement as if each of them 

had been a party hereto as an Author. The Author warrants 

that the use, reproduction, distribution, public or private 

performance or display, and/or modification of all or any 

portion of the Materials does not and will not violate, 

infringe and/or misappropriate the patent, trademark, 

intellectual property or other rights of any third party. The 

Author represents and warrants that it has and will 

continue to comply with all government, institutional and 

other regulations, including, without limitation all 

institutional, laboratory, hospital, ethical, human and 

animal treatment, privacy, and all other rules, regulations, 

laws, procedures or guidelines, applicable to the Materials, 

and that all research involving human and animal subjects 

has been approved by the Author's relevant institutional 

review board. 

11. JoVE Discretion. If the Author requests the 

assistance of JoVE in producing the Video in the Author’s 

facility, the Author shall ensure that the presence of JoVE 

employees, agents or independent contractors is in 

accordance with the relevant regulations of the Author's 

institution. If more than one author is listed at the 

beginning of this Agreement, JoVE may, in its sole 
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discretion, elect not take any action with respect to the 

Article until such time as it has received complete, executed 

Article and Video License Agreements from each such 

author. JoVE reserves the right, in its absolute and sole 

discretion and without giving any reason therefore, to 

accept or decline any work submitted to JoVE. JoVE and its 

employees, agents and independent contractors shall have 

full, unfettered access to the facilities of the Author or of 

the Author’s institution as necessary to make the Video, 

whether actually published or not. JoVE has sole discretion 

as to the method of making and publishing the Materials, 

including, without limitation, to all decisions regarding 

editing, lighting, filming, timing of publication, if any, 

length, quality, content and the like.  

12. Indemnification. The Author agrees to indemnify 

JoVE and/or its successors and assigns from and against any 

and all claims, costs, and expenses, including attorney’s 

fees, arising out of any breach of any warranty or other 

representations contained herein. The Author further 

agrees to indemnify and hold harmless JoVE from and 

against any and all claims, costs, and expenses, including 

attorney’s fees, resulting from the breach by the Author of 

any representation or warranty contained herein or from 

allegations or instances of violation of intellectual property 

rights, damage to the Author’s or the Author’s institution’s 

facilities, fraud, libel, defamation, research, equipment, 

experiments, property damage, personal injury, violations 

of institutional, laboratory, hospital, ethical, human and 

animal treatment, privacy or other rules, regulations, laws, 

procedures or guidelines, liabilities and other losses or 

damages related in any way to the submission of work to 

JoVE, making of videos by JoVE, or publication in JoVE or 

elsewhere by JoVE. The Author shall be responsible for, and 

shall hold JoVE harmless from, damages caused by lack of 

sterilization, lack of cleanliness or by contamination due to 

the making of a video by JoVE its employees, agents or 

independent contractors. All sterilization, cleanliness or 

decontamination procedures shall be solely the 

responsibility of the Author and shall be undertaken at the 

Author’s expense. All indemnifications provided herein 

shall include JoVE’s attorney’s fees and costs related to said 

losses or damages. Such indemnification and holding 

harmless shall include such losses or damages incurred by, 

or in connection with, acts or omissions of JoVE, its 

employees, agents or independent contractors. 

13. Fees. To cover the cost incurred for publication, 

JoVE must receive payment before production and 

publication of the Materials. Payment is due in 21 days of 

invoice. Should the Materials not be published due to an 

editorial or production decision, these funds will be 

returned to the Author. Withdrawal by the Author of any 

submitted Materials after final peer review approval will 

result in a US$1,200 fee to cover pre-production expenses 

incurred by JoVE. If payment is not received by the 

completion of filming, production and publication of the 

Materials will be suspended until payment is received. 

14. Transfer, Governing Law. This Agreement may be 

assigned by JoVE and shall inure to the benefits of any of 

JoVE’s successors and assignees. This Agreement shall be 

governed and construed by the internal laws of the 

Commonwealth of Massachusetts without giving effect to 

any conflict of law provision thereunder. This Agreement 

may be executed in counterparts, each of which shall be 

deemed an original, but all of which together shall be 

deemed to me one and the same agreement. A signed copy 

of this Agreement delivered by facsimile, e-mail or other 

means of electronic transmission shall be deemed to have 

the same legal effect as delivery of an original signed copy 

of this Agreement.
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Authors comments: 1 

We would like to express our gratitude for the insightful comments made by the reviewers of our 2 

manuscript. Their attention to detail and generous suggestions made revising this work a less difficult 3 

endeavor. We would especially like to thank reviewer #1 for his/her extensive input. His/her 4 

contribution to the review of this work will certainly enhance the quality of the published paper and 5 

video.  6 

Below each editor’s or author’s comment, we have placed our response to the suggested change or edit.  7 

Editorial comments: 8 

Changes to be made by the Author(s): 9 

1. Please take this opportunity to thoroughly proofread the manuscript to ensure that there are no 10 

spelling or grammar issues. The JoVE editor will not copy-edit your manuscript and any errors in the 11 

submitted revision may be present in the published version. 12 

 We have checked and revised the manuscript for this.  13 

2. Please rephrase the Short Abstract/Summary to clearly describe the protocol and its applications in 14 

complete sentences between 10-50 words: “Here, we present a protocol to …” 15 

 Both abstract and summary have been revised.  16 

3. Please ensure the Introduction to include all of the following: 17 

a) A clear statement of the overall goal of this method 18 

b) The rationale behind the development and/or use of this technique 19 

c) The advantages over alternative techniques with applicable references to previous studies 20 

d) A description of the context of the technique in the wider body of literature 21 

e) Information to help readers to determine whether the method is appropriate for their application 22 

 We believe the current introduction covers these criteria.  23 

4. Please ensure that all text in the protocol section is written in the imperative tense as if telling 24 

someone how to do the technique (e.g., “Do this,” “Ensure that,” etc.). The actions should be described 25 

in the imperative tense in complete sentences wherever possible. Avoid usage of phrases such as “could 26 

be,” “should be,” and “would be” throughout the Protocol. Any text that cannot be written in the 27 

imperative tense may be added as a “Note.” However, notes should be concise and used sparingly. 28 

Please ensure that all text in the protocol section is written in the imperative tense as if telling someone 29 

how to do the technique (e.g., “Do this,” “Ensure that,” etc.). The actions should be described in the 30 

imperative tense in complete sentences wherever possible. Avoid usage of phrases such as “could be,” 31 

Rebuttal Letter Click here to access/download;Rebuttal
Letter;Response_to_reviewers_and_editor_comments.docx
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“should be,” and “would be” throughout the Protocol. Any text that cannot be written in the imperative 32 

tense may be added as a “Note.” However, notes should be concise and used sparingly. 33 

 We made sure to use the active voice and imperative sentences throughout the manuscript.  34 

5. The Protocol should contain only action items that direct the reader to do something. The Protocol 35 

should be made up almost entirely of discrete steps without large paragraphs of text between sections. 36 

Please simplify the Protocol so that individual steps contain only 2-3 actions per step and a maximum of 37 

4 sentences per step. Please add more details to your protocol steps. Please ensure you answer the 38 

“how” question, i.e., how is the step performed? 39 

 We feel we have provided enough direction in each protocol step to answer the “how” 40 

question. 41 

7. Software steps must be more explicitly explained ('click', 'select', etc.). Please add more specific 42 

details (e.g. button clicks for software actions, numerical values for settings, etc.). 43 

 We made sure to write easy-to-follow directions in the Fiji software section.  44 

8. Please highlight 2.75 pages or less of the Protocol (including headings and spacing) that identifies the 45 

essential steps of the protocol for the video, i.e., the steps that should be visualized to tell the most 46 

cohesive story of the Protocol. 47 

 The protocol sections we highlighted provide sufficient information required to understand 48 

the objective of this protocol. 49 

9. Please remove all commercial language from your manuscript and use generic terms instead. All 50 

commercial products should be sufficiently referenced in the Table of Materials and Reagents. 51 

 We have removed all commercial language and limit it to the materials table. 52 

For example: VALAP, GE Healthcare/Applied Precision, Issaquah, WA, DeltaVision restoration 53 

microscope, Olympus 60x NA 1.4 PlanApo objective, softWorRx (v3.3 or higher), 12-bit Roper CoolSnap 54 

HQ, etc. 55 

10. As we are a methods journal, please revise the Discussion to explicitly cover the following in detail in 56 

3-6 paragraphs with citations: 57 

a) Critical steps within the protocol 58 

b) Any modifications and troubleshooting of the technique 59 

c) Any limitations of the technique 60 

d) The significance with respect to existing methods 61 

e) Any future applications of the technique 62 

 We feel our discussion addresses these criteria well.  63 

11. For all the figures with microscope, please include a scale bar. 64 

 All microscope images have a scale bar.  65 



12. Please alphabetically sort the materials table. 66 

 The table is alphabetized.  67 

13. Please obtain explicit copyright permission to reuse any figures if from a previous publication. 68 

Explicit permission can be expressed in the form of a letter from the editor or a link to the editorial 69 

policy that allows re-prints. Please upload this information as a .doc or .docx file to your Editorial 70 

Manager account. The Figure must be cited appropriately in the Figure Legend, i.e. “This figure has been 71 

modified from [citation].” 72 

 All the work in this protocol is original.  73 

Reviewers' comments: 74 

 75 

Reviewer #1: 76 

Manuscript Summary: 77 

In this manuscript the authors have provided a thorough explanation of the method of live imaging of 78 

fission yeast. The authors have provided a complete workflow for the entire process. Details on cell 79 

culture and sample prep are provided. Details on data acquisition including imaging parameters and 80 

optical component selection are shown. Some common tools for image analysis specifically for nuclear 81 

processes including the use of Fiji are provided. Finally, interpretation of the imaging data including 82 

specific plots and analyses are provided, as well as a list of useful proteins to tag for visualization. 83 

 84 

Major Concerns: 85 

The authors have focused on the analysis of nuclear processes in this method, but I feel that the authors 86 

would provide a greater benefit to the scientific community if they expanded to include other cellular 87 

processes other than the nucleus. This change would not take much effort for the authors since all parts 88 

of the method can be generalized for any cellular process. The only place the method would need to be 89 

expanded is to require a larger list of proteins to tag for other processes and a brief explanation of how 90 

to interpret the data using montages, kymographs and intensity quantifications, etc. I'm not suggesting 91 

this be a comprehensive list of all cellular process but including details on proteins which tag other 92 

organelles would be extremely useful to the community. 93 

 We have included a note that refers readers to Table I, which contains select markers for 94 

dynamics occurring in the nucleus as well as the cytosol. This suggestion was very helpful.  95 

My only real concern with the method the way it is written are the details on image thresholding and 96 

ROI selection for measurements. The authors have shown proteins for the method that are bright and 97 

easily segmented. The specific use of the default thresholding method in Fiji works well for these 98 



particular proteins, but for greater applicability to the community a discussion of other segmentation 99 

methods for markers that may be dim and/or diffuse would be useful. Careful selection of the 100 

thresholding algorithm is an important part of the image processing workflow and the selection of the 101 

wrong method will lead to erroneous results. 102 

 We make mention of this caveat and refer readers to the appropriate sources for learning how 103 

to distinguish between thresholding methods based on their experimental requirements.  104 

Finally Figure 5A is confusing the way it is constructed now. I can appreciate the fact that the figure is 105 

trying to relay a lot of information in a small format, but its current construction makes it difficult to 106 

figure out what is going on. I would propose removing the inverted LUT column and separating the 107 

transmitted light and the fluorescence channels into their own columns. I further understand that some 108 

of the proteins appear/disappear over time and therefore will have blank panels down the montage of 109 

when they are not on. Leaving the blank panels will help clarify the timing of the proteins with respect to 110 

the cell cycle and make the figure much clearer. 111 

 We have decided to leave this figure without any modifications for the following reasons: 112 

a. We added an interpretation box that along with the manuscript description will help 113 

readers better understand the panels in this figure. 114 

b. Because the BF image is made from a meiosis movie, which goes for 8 hours, the 115 

transmitted light is too dim to offer any cell details other than the cell outline. This is 116 

done so as to not to photo-bleach our sample prematurely. Thus, the bright field 117 

merge helps use to use color inversion to make the pombe outline easier to see.  118 

c. The LUT panel is helpful to consider when dealing with diminishing signal, for it allows 119 

readers to detect small changes in fluorescence. Thus, we wish to feature it when 120 

possible.  121 

d. Including more blank images at the end of MII is difficult because sporulation 122 

introduces cell-shifting, which moves the focal plane.  123 

e. Overall, we feel that the changes we made thanks to the recommendations of all the 124 

reviewers makes this figure more understandable.  125 

Minor Concerns: 126 

-Section 3.1.1 I appreciate the use of the tip box for the slide making apparatus, but it's unclear to me 127 

what purpose this serves. Wouldn't the lab bench work just as well? 128 

 The lab bench works just fine. We recommend using a makeshift slide-maker for consistency. 129 

Thus, we added a note to that section of the protocol that encourages the use of a slide-maker 130 

but leaves it up to the reader to decide.  131 

-Section 3.1.2 the figure reference here should be 1C. 132 

 We have corrected this.  133 

-Section 3.1.2 line 180. "The size of the agarose pad is typically inversely proportional to the length of 134 

imaging time." This should read "The size of the agarose pad is typically proportional to the length of 135 

imaging time." A larger agarose pad for long timelapses and vice versa. 136 



 We have corrected this.  137 

-Section 3.1.3 Nail polish typically doesn't quench fluorescence and is not usually autofluorescent. 138 

However, sealing large gaps is typically hard to accomplish with nail polish and it may kill the cells. 139 

 This is a great point. We have modified this protocol step to match the reviewer’s suggestion.  140 

-Section 3.2.4 17949 g is a very specific setting. Is this necessary? 141 

 It was a typo that we have corrected.  142 

-Section 3.2.5 As this section now reads, one should place 20uL of cell suspension onto the pad and then 143 

invert the pad and touch it to a lint-free paper towel. Is this the correct order? If removing excess liquid 144 

from the pad, shouldn't that be done before placing the cells? If removing excess liquid from the 20uL of 145 

cell suspension, wouldn't allowing a couple minutes for the excess liquid to absorb into the agarose take 146 

care of the problem? Line 213 Should read "Figure 1D" but now reads "Figure D". Line 214 should read 147 

"Figure 1F" but now reads "Figure 1E". 148 

 The paper drying step is more time-efficient than gravity absorption. We made a note of this 149 

because meiosis movies are time sensitive during the stage where karyogamy and nuclear 150 

fusion are happening.  151 

 The figure mislabeling was also corrected.  152 

-Section 3.2.7 line 226 should be Figure 1H 153 

 This has been corrected.  154 

-Section 4.1.3 Depending on the experiment and what is to be learned, I think this objective 155 

requirement is slightly too high. I would recommend at minimum a 40x objective with NA > 1.2. 156 

 We agree with the reviewer and modified the manuscript to reflect his/her recommendation.  157 

-Section 4.1.4 Please reference the ImageJ deconvolution package by name, cite their paper (if 158 

applicable) and link to the online reference material. 159 

 We refer the readers to the proper software websites and citations.  160 

-Line 273 "and 13 5-um sections" This is a confusing way to reference the z-stack settings. Do the 161 

authors mean 13 sections covering 5 microns total distance? Or do the authors mean 13 sections with 5 162 

micron spacing? The former is appropriate but is dependent on the objective employed while the latter 163 

would miss the cells entirely. If this is the only place the z stack settings are mentioned, the authors 164 

should talk about proper z sampling dependent on the objective used and formalize the z stack settings 165 

in the manner "13 sections with 0.38 micron spacing covering a total depth of 5um". 166 

 We agree with the reviewer and have implemented her suggested change.  167 

-Section 4.1.9 "using 9-13 serial z-sections with 5um spacing is enough to resolve the thickness of a 168 

fission yeast cell". Please clarify as discussed in the previous comment. 169 

 We have made this correction as per the reviewer’s previous suggestion.  170 



-Section 5.1.1 The authors referenced ImageJ above and Fiji here. For people not familiar with either, 171 

this will be confusing. If the authors meant Fiji throughout, please change all references. 172 

 We have changed ImageJ for Fiji throughout the manuscript for more clarity.  173 

-Section 5.1.3 is mislabeled. It should be 5.1.6. Additionally, it's not necessary to go through all ROIs by 174 

hand and select measure each time. In the ROI manager, under the more button, there is a button 175 

labeled multi measure. In the subsequent pop-up box, make sure "measure all slices" is selected, 176 

deselect the "one row per slice" option and then click OK. This will measure all the ROIs iteratively. 177 

 We have added a note which stipulates that if cell-shifting isn’t an issue, automatic iteration is 178 

the prefer option.  179 

-Section 5.1.4 line 350 should be 5.1.7 180 

 This has been corrected.  181 

-Line 358 histograms should be profiles 182 

 This has been corrected.  183 

-Section 5.1.5 line 364 should be 5.1.8 184 

 We have modified this.  185 

-Section 5.1.6 line 372 should be 5.1.9 186 

 We have corrected this.  187 

-Section 5.1.7 line 380 should be 5.1.10. It's important to note also for the montage instructions that not 188 

necessarily every frame needs to be included, so adding a line about the increment setting would be 189 

useful. 190 

 We implemented the reviewer’s suggestion.  191 

-Section 5.1.8 line 394 should be 5.1.11. In using the time stamper tool, the end point is not a setting, 192 

but it is necessary to input the appropriate time between frames. 193 

 We agree with the reviewer and have modified this step.  194 

The transmitted light images in Figure 2 are noisy due to too little light intensity from the transmitted 195 

light bulb. It would be beneficial to other readers to have brighter images to better illustrate the texture 196 

and septa for starved and dividing cells, respectively. Additionally, it would be convenient for readers to 197 

have the transmitted light and fluorescence images be from the same field of view. This would help 198 

readers to correlate the appearance of the different channels in deciding whether their cells are healthy. 199 

 These images have been changed for better quality ones.  200 

-Line 436,439 states Hht1-mRFP but Figure 2A shows Hht1-GFP. Please clarify. 201 

 We have corrected this mistake in the manuscript.  202 

 203 



-Figure 3D would be much clearer if the kymograph was extended in the vertical direction and if 204 

septation were marked in time on the side of the kymograph. As it stands now, I can't correlate the 205 

change in GFP expression with the division and whether that happens before septation. 206 

 This has been changed to reflect the reviewer’s preference.  207 

-Figure 3E would benefit from having the transmitted light included as a separate channel. 208 

 We prefer to have a merge channel in this figure.  209 

-Figure 4A Please label the second column. Is it segmented Hht1-mRFP? 210 

 We have placed numbers atop each panel that identifies it with its markers.  211 

Reviewer #2: 212 

Manuscript Summary: 213 

The authors describe the practical application of live-cell microscopy in studies of events associated with 214 

mitosis and meiosis in fission yeast, a favorite model in the fields of cell and molecular biology. The 215 

provided protocols describe steps from media preparation, through cell cultivation, to microscopy of 216 

living cells, and the subsequent quantitative image analysis with the popular imageJ/fiji package. The 217 

manuscript is informative and reads very well, the procedures are well-described and complemented 218 

with illustrative representative results. Critical steps/parameters of the workflow are properly 219 

highlighted, and limitations of the method are discussed. The image analysis part of the workflow is of 220 

interest also to researchers outside the fission yeast community. Overall, the manuscript provides very 221 

useful information and deserves to be published. I have only some minor comments and suggestions to 222 

further improve the paper, as detailed below. 223 

 224 

Minor Concerns: 225 

- it would be great to include sample raw image data (eg. the files used to produce Figs. 2-5) to help 226 

users learn to use fiji (perhaps by making the data available through Figshare). 227 

 We will submit an avi movie with the final manuscript.  228 

- the authors might want to state more explicitly that fiji (not just plain imageJ) is needed for the 229 

described analyses 230 

 We have corrected this throughout the manuscript.  231 

- line 180: please explain why "the size of the agarose pad is typically inversely proportional to the 232 

length of imaging time". This was not clear to me. 233 

 That was wrongly stated, and we have corrected it in the manuscript.  234 

- references 18-20 are cited prior to refs. 15-17 235 



 This has been corrected.  236 

- line 78: MgCl2 quantity seems to be 10x higher than needed 237 

 That was indeed a typo and was promptly corrected.  238 

- lines 91, 119: uracil and adenine are not "amino acids" 239 

 We changed this to nutrients.  240 

- lines 104, 116, 128: agar will not dissolve without heating 241 

 We have corrected this in the manuscript. Now readers know that agar melts during 242 

autoclaving.  243 

- line 273, 285: optical slices of 5 um seem too thick (the whole fission yeast is thinner than that). 244 

Perhaps you meant 0.5 um? 245 

 This was incorrect and we changed it to the right magnitude: 0.5 um.  246 

- line 273: "1 GB of memory" - do you mean RAM or hard drive storage space? Please clarify. 247 

 We adopted the reviewer’s suggestion.  248 

- line 384: I found the description of creating AVI movies a bit confusing. Users need to convert the 249 

hyperstack to AVI, not the montage image to AVI. 250 

 We changed it to say that a hyperstack is needed to generate an avi movie.  251 

- line 398: in my imageJ (1.52i) the Time Stamper tools is located under Image/Stacks, not in Plugins. 252 

Please double check. 253 

 We corrected this and adopted the reviewer’s suggestion.  254 

Reviewer #3: 255 

Manuscript Summary: 256 

The manuscript outlines best practices for preparing and imaging fission yeast for live-cell studies of 257 

mitosis and meiosis. Methods for processing and analysis of the resulting images are also given. The 258 

authors show how fluorescent protein fusions can be used to follow structures important in mitosis and 259 

meiosis, and show how to recognize healthy and unhealthy cells. The advice on fusion proteins and 260 

image analysis will be useful for any S. pombe researchers whose work relates to the cell cycle or 261 

meiosis, and the tips for evaluating and maintaining cell health will be useful for anyone performing live 262 

imaging of fission yeast. The protocol has a useful level of detail, highlights potential pitfalls, and is 263 

clearly written. 264 

 265 

Major Concerns: 266 



None. 267 

 268 

Minor Concerns: 269 

-2.1.2: For the starter liquid culture, are there guidelines for the size of the tube (e.g. to guarantee 270 

sufficient aeration) or the shaking speed? 271 

 A note has been added to address this.  272 

-3.1.2: It would be helpful to say how thick the agarose pad should be for different time-lapse durations. 273 

 Pad thickness will depend on a researcher’s reagents, agarose type, microscope temperature, 274 

etc. Thus, we added a note that addresses this by stating that optimization for each 275 

researcher’s experiment needs is required.  276 

-3.2.4. "centrifuge at 17,949 x g" - this seems high. Is it a typo? 277 

 This type has been corrected.  278 

-4.1.4. Not all deconvolution algorithms are appropriate for quantitative analysis of intensity. Specific 279 

examples of ImageJ plugins, and deconvolution algorithms, should be given that allow images to be 280 

restored without distorting intensity data, and guidance should be given on avoiding artifacts. If the 281 

authors feel this exceeds the scope or space limitations of the article, they should give references that 282 

provide advice on deconvolution for quantitative analysis. 283 

 Readers are referred to the appropriate online guides and published literature on the subject.  284 

-4.1.8. "…as long as excitation and emission do not decrease …" This should probably read "…as long as 285 

emission does not decrease…." 286 

 We adopted the reviewer’s suggested change.  287 

-5.1.3. "Use the Wand tool to highlight each ROI…" should probably be "Use the Wand tool to highlight 288 

each structure of interest..." As a side note, to measure a set of saved ROIs in current versions of Fiji, 289 

you can select all the ROIs in the ROI Manager and click Measure in the ROI Manager to obtain all the 290 

slice measurements in a single step. 291 

 We added a note stating that if cell-shifting is not an issue, the automated measurement 292 

option is preferred.  293 

-5.1.4. "Lack of overlap among signal histograms…." should be "Lack of overlap among profile plots…" 294 

 We corrected this to reflect the reviewer’s suggestion.  295 

-Figure 5A. The legend does not explain the green circles in the lower half of the 3rd column, or the 4th 296 

column (shown in inverted Fire LUT). 297 

 We have labeled each of the image panels and have added a label that indicates the outlined 298 

foci are GFP signals.  299 



-Discussion: "…not exposing cells to high-frequency wavelengths…" should be "… not exposing cells to 300 

short wavelengths…" 301 

 This is correct. We changed it to reflect the reviewer’s suggestion.  302 



Dear Vineeta Bajaj, 

 

We appreciate all the constructive comments you made about our manuscript. Your insightful 

comments allowed us to modify this manuscript version into what we believe is a much clearer form. 

We would particularly like to thank you for the useful suggestions you provided for protocol steps that 

fit better in the discussion section. This made for a cleaner protocol segment. Also, we connected 

phenotypes to their correct figure panels in no small part thanks to your careful reading of this 

manuscript section. It is clear to us that your recommended changes have made this part a lot clearer 

than was the case in the previous version of our manuscript. All in all, we greatly appreciate your help to 

make this JOVE protocol more useful to all in the fission yeast community.  

 

Response to editor comments 

 

1. Introduction 

Please include a paragraph here describing how and what you are trying to do in your experiment. 

Introduce all the proteins used here. 

The goal of the manuscript is to present live cell imaging to study mitosis and meiosis in yeast. To do this 

xx protein is fluorescently tagged …. We studied the expression of xxx protein because….  

Bring out all the details here. 

 We agree with Vineeta Bajaj on the need for more details in the introduction section. Thus, we 

added an additional paragraph (Lines 74-86) detailing the main sections of the protocol as well 

as the fluorescently tagged proteins featured in Figures 2-5.  

 We also add a thesis sentence in this additional paragraph that voices the specific goal of this 

protocol.  

2. Protocol 

Please do not have paragraph of text in the protocol section.  

Please ensure that all the steps are as crisp as possible. 

We cannot have paragraph of texts in the protocol section.   

Also, the protocol section cannot be more than 10 pages and highlight cannot be more than 2.75 pages 

including headings and spacings. Please highlight complete sentences and not the part of a sentence. 

Please ensure that the highlights form a cohesive story. 

 We removed unnecessary sub-sections as indicated by Vineeta Bajaj.  

 We removed unnecessary words. 

 We replaced passive phrases, with imperative ones.  

Rebuttal Letter 2 Click here to access/download;Rebuttal Letter;Response to
editor.docx
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 We removed parts of protocol steps that contributed to paragraph blocks in the previous 

version of this manuscript.  

 We modified highlights to fit 2 ¾ pages and to include complete sentences.  

 The highlights now take you from yeast colony to live-cell images in a more sequential manner.  

 We also eliminated unnecessary notes and moved others to the discussion section, where they 

fit better.  

3. Live-cell imaging and processing (Lines 264-292) 

Please use imperative tense throughout the steps in this section as if describing someone how to 

perform your experiment with all specific details.  

Please ensure each step is showing a discrete action and describe how to do that step with all 

specific detail.  

Please remove the redundancy from the steps and make it crisp with respect to your experiment 

and present discrete experimental steps only.  

Discussion about the protocol can be moved to the discussion section.  

The above step 3 ends with slides being equilibrated. E.g.,  

4.1. step 4 should start with bringing and placing the slide on the microscope stage.  

4.2. Then adjust the magnification to 40x or 60x to get a better view. Please also explain whether 

you adjust the objective and aperture manually or do you perform any button clicks in the 

associated software.   

 We used more imperative language and modified steps to refrain from the passive voice.  

 We changed some steps to add more clarity and better instructions for readers to follow.  

 We eliminated redundant parts or merged them into more cohesive sentences for different 

steps.  

 Step segments or notes that were superfluous in the protocol section were moved to the 

discussion section, where they fit better now.  

 The last step of section 3 and the beginning portion of section 4 are now in the proper 

sequence of events.  

 The move from 40x to 60x is mentioned and the functional details of microscope 

manipulation are addressed.  

This is not a step, converted to a note instead (Line 273) 

 We agree with the editor and retained that step as a note. 

How do you use fiji to do so? Since this is marked for filming, please provide the steps in brief (Line 291).   

 We removed the highlight from this step because it did not go well with the narrative we 

wish to have in the video. Readers, however, are provided with multiple citations that show 

them how to carry out that step.  



How? Do you perform some knob turns in the microscope or button clicks in the software to adjust to 

the MES? (Line 304) 

 We agree with the editor that this sentence was confusing. We rectified it by stating MESA is 

an approach and then had an additional sentence to explain its meaning.  

This is not a note, hence converted to a step instead.  Notes” should be concise and used 
sparingly. They should only be used to provide extraneous details, optional steps, or 
recommendations that are not critical to a step. Any text that provides details about how to 
perform a particular step should either be included in the step itself or added as a sub-step (Line 
314). 

 We agree with the editor and changed this step as suggested.  
 

Please reword and make the step crisp.  

 We carried out this throughout this section.  
 

For the 8h time period do you move the cells back and forth to the incubator and to the microscope 

stage? Do you maintain the temperature on the stage itself with some sort of temperature controller? 

Please detail all specific details which will be helpful to reproduce the experiment. 

 In section 3, we include a note where we made mention of the need for considering proper 

temperature control depending on their microscope systems.  

How? (Line 321). 

 We provide multiple citations so the reader can learn how to generate an appropriate 

experimental workflow.  

How is this done? (Line 330) 

 We also provide references for people to look up how to do pilot intensity analysis 

experiments.  

This is not a step but just a discussion. Please consider moving this to the discussion section. (Line 333) 

 We agreed with the editor and moved this to the discussion section.  

How do you apply the same? (Line 340) 

 This varies from software to software, so we made mention of that fact. Most software use 

for these purposes presents it as a choice when making image deconvolution and 

projection. We also provide references that talk about this part.  

Please use imperative tense throughout the steps in this section.  
 
Please ensure each step is shows a discrete action and describe how to do that step with all 
specific detail.  
 



Also, we cannot have paragraph of text in the protocol section. Please ensure each step should not 

describe more than 2-3 action. Please consider making substeps. 

 We modified our language and made it more imperative.  

 We broke paragraph blocks into steps and sub-steps as suggested by the editor. 

 Overall, we streamlined this section for easier understanding.  

If 5.17 described how to do the step 5.16, please remove 5.16 and renumber accordingly (Line 451). 

Please make substeps shown from step 5.1 -5.17. Each step should not have more than 2-3 action (Line 

470).   

 We renumbered steps to their correct sequence. 

 We reduced the size of each step.  

 We changed the language to be less passive and more imperative.  

Please reword the result with respect to your experiment, you performed an experiment, how did it 

helped you to conclude what you wanted to and how is it in line with the title. Please do not generalize 

(Line 499).  

Need more clarity for figure description. 

Again, which panels show this transition. Please first explain which time point corresponds to what 

phase of mitosis to bring out clarity. 

 We changed wording so the narrative of the results section is more coherent.  

 We linked sentences describing nuclear dynamics to their correct figures and panels.  

 We added sentences that explained what the results mean.  

 We added specific times for each of the panels and figures mentioned in this section.  

Why this is used? References if any? Include the reference (Line 546) 

 Reference for this  marker is provided previously in the same paragraph.  

Is this figure is cut? Please check. (Line 564) 

 Figure 3D is not cut, but we could not show the rest of the kymograph because of cell-

shifting, which cause the field of view to change in the last slices of that stack. We make 

mention of this effect in the section related to Fiji.  

What is the time point here (which panel shows this)? (Line 598) 

 We corrected this to show the panel and time when the specific phenotype is observed.  

We cannot have interpretation panel in the figure itself. Please move the details to the representative 

result and refer to the time points as well to bring out clarity in understanding the figure (Line 606). 

 We removed the interpretation box from figures 4 & 5.  

 


